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INSTALLATION AND REGISTRATION
Installation and Registration Messages
Minimum System Requirements
Installation
Registration
Upgrading from AT&T WorldNet Service 1.0 Software

Installation and Registration Messages
The following messages may appear during the installation and registration processes.    Click on the 
green text to see an explanation of the corresponding message.    When you have finished, you can 
click on the “Back” button above to return to this page of the Troubleshooting Guide.
Your system is enabled for another Domain Name System (DNS) server
When using the Intenet, Windows 95 requires users to log on to their computer. . .
You must install Windows 95 Dial-Up Networking before registering
Could not add WorldNet DNS address 
An existing installation of Netscape Navigator software has been found on your machine.    Your 
preferences have been saved. 

Minimum System Requirements
To run the AT&T WorldNet Service software, you will need the following on your PC:

    Windows 95
    386 processor    minimum, 486 processor or better recommended
    8 MB RAM or more
    11 MB free hard disk space or more
    14.4 Kbps modem or better
    VGA Monitor or better
    Windows 95 Dial-Up Networking installed

This software allows you to register and connect with AT&T WorldNet Service using a normal dial-
up telephone connection.    It is not designed to enable access to AT&T WorldNet Service via a 
Local Area Network (LAN).

Installation
Before installing the AT&T WorldNet Service software, we recommend that you exit all Windows 
applications. Also, you must close your Dial-Up Networking folder, if it is open.    If it is left 
open, the Dial-Up Networking connection may not get created.    (See The Account Setup Wizard 
did not create a   “  Shortcut to AT&T WorldNet  ”   icon.       )

With Windows 95 running, insert your AT&T WorldNet Service CD-ROM or floppy disk 1 in the 
appropriate drive.    After you have closed all Windows applications and your Dial-up Networking 
folder, click on the “Start” menu and choose the "Run" option. Type a:\setup (if you are not using 
drive A:, substitute the appropriate drive letter) and press Enter. Follow the onscreen instructions. 

You will see a window that asks you where to install the AT&T WorldNet Service software. We 
recommend that you install the software in the default directory (usually C:\PROGRAM FILES\
WORLDNET) displayed in the “Destination Directory” box.    If you already have AT&T WorldNet 
Service software version 1.0 installed on this machine, we strongly recommend that you do 
not install this new version in the same directory (usually C:\WorldNet).    If you do install 



version 2.0 in the same directory as version 1.0, uninstalling version 1.0 will also remove your 
version 2.0 program files.

If Dial-Up Networking is not already on your PC, you will be asked if you want to install it at this 
time.      If you have your Windows 95 installation CD-ROM or floppies, you can go ahead and elect 
to install it now.    You can also elect to install it later, but you must install Dial-Up Networking before
you will be able to register with AT&T WorldNet Service.    If you choose not to install Dial-Up 
Networking as part of the AT&T WorldNet Service installation procedure, you can install it later by 
following the instructions in How to Install Dial-Up Networking and TCP/IP.

Registration
After installing the AT&T WorldNet Service software, you will need to run the Account Setup Wizard
to set up your account and register with the AT&T WorldNet Service.    To run the Account Setup 
Wizard, double-click on the "Double Click to Set Up Account" icon in the "AT&T WorldNet Service" 
folder.    If you already access the AT&T WorldNet Service from this PC (using Version 1.0 of the 
AT&T WorldNet Service software), see the section titled Upgrading From AT&T WorldNet Service 
Version 1.0.

In order to create a new AT&T WorldNet Service account, the Account Setup Wizard will first ask 
you for your name, address, and billing information.    Next, the Account Setup Wizard will gather 
the information it needs to set up your modem. It is recommended that you allow the Account 
Setup Wizard to automatically detect your modem. If the Modem Setup can't determine your 
modem type, you'll need to specify the information by choosing your modem from the modem list. 
If your modem isn't listed, choose Hayes-compatible as the modem type to use during registration. 
If this fails, please call AT&T WorldNet Service Customer Care.

Finally, click on the "Connect" button and follow the onscreen instructions to complete the 
registration process.

Once you have registered, we recommend that you make a backup copy of your account 
information.    See How to Back Up Your AT&T WorldNet Service Account Information.



Upgrading From AT&T WorldNet Service 1.0 Software
If you already access AT&T WorldNet Service from this PC (using Version 1.0 of the AT&T 
WorldNet Service software), the Account Setup Wizard can update your dialing information to work
under Windows 95. To update your dialing information, perform the following steps:

1. Double click on the “Double Click to Set Up Account” icon in the “AT&T WorldNet Service” 
folder.

2. Click on the “Next>” button on the opening screen.

3. On the “Updating Your Dialing Information” screen, select the “Yes” option, and click on the 
“Next>” button.

4. On the “Modem Information” screen, check to see that the modem displayed is the correct 
modem. If it is not, click on the “Modem Wizard” button, and follow the onscreen instructions. 
When the correct modem is displayed, click on the “Next>” button.    If the Modem Wizard can't
determine your modem type, you'll need to specify the information by choosing your modem 
from the modem list. If your modem isn't listed, choose Hayes-compatible as the modem type 
to use during registration.    If this fails, please call AT&T WorldNet Service Customer Care.

5. On the “Exploring The Internet” screen, click on the “Finish” button to finish updating your 
dialing information.

When you upgrade from the AT&T WorldNet Service Version 1.0 software, the following 
preferences/settings will be updated to work with the Version 2.0 software:

Home Page
Bookmarks
Email Configuration
News Configuration

Any email that you had previously stored in Eudora Light email folders will not be automatically 
upgraded. However, if you wish, you can manually copy the contents of the Eudora Light mailboxes to 
the corresponding Version 2.0 mailboxes. To copy your old email, see Mailbox Migration.

Home Page
Your home page will be copied from the AT&T WorldNet Service Version 1.0 software. To view the 
home page entry:

1. Start the AT&T WorldNet Service Browser (you do not need to connect to AT&T WorldNet Service).

2. Select the “General Preferences” option from the “Options” menu.

3. Click on the “Appearance” tab. The value will appear in the “Start With” field.

Bookmarks
Your bookmarks will be copied from the AT&T WorldNet Service Version 1.0 software. You can 
view your bookmarks by clicking on the “Bookmarks” menu in the AT&T WorldNet Service 
Browser.

Email Configuration
The following email configuration items will be copied from the AT&T WorldNet Service Version 1.0 
software:

    POP User Name (Email ID)



    Incoming Mail (POP) Server
    Outgoing Mail (SMTP) Server

To view the values for the above items:

1. Start the AT&T WorldNet Service Browser (you do not need to connect to AT&T WorldNet Service).

2. Select the “Mail and News Preferences” option from the “Options” menu.

3. Click on the “Servers” tab.

Note: If you want to maintain or preserve access to your previous email messages saved in local 
Eudora mailboxes, see Mailbox Migration.

News Configuration
Your News server value will be copied from the AT&T WorldNet Service Version 1.0 software. To 
view the News server entry:

1. Start the AT&T WorldNet Service Browser (you do not need to connect to AT&T WorldNet Service).

2. Select the “Mail and News Preferences” option from the “Options” menu.

3. Click on the “Servers” tab - the value appears in the “News (NNTP) Server” field.

Mailbox Migration
If you want to maintain or preserve access to your previous email messages saved in local Eudora 
mailboxes, you need to copy files from the original Eudora directory (usually C:\WORLDNET\
EUDORA) to the new AT&T WorldNet mail directory (usually C:\PROGRAM FILES\WORLDNET\
PROGRAM\MAIL).    

To do this, perform the following steps:

1. Open Windows Explorer or File Manager.

2. Open the Version 1.0 installation directory (usually C:\WORLDNET).

3. Open the EUDORA subdirectory.

4. In this directory, you should see several files with a “mbx” file extension, such as “in.mbx”.    
These are your existing email boxes.    Select all the files with the “mbx” extension .

5. Drag them to the mail subdirectory of the new AT&T WorldNet directory, usually C:\PROGRAM
FILES\WORLDNET\PROGRAM\MAIL.

6. Now rename these “mbx” files by selecting each file, then selecting the “Rename” option from
the file menu, and rename them as shown below:
“in.mbx” should be renamed “in”    (Answer yes to overwrite an existing file)
“out.mbx” should be renamed “sent” (Answer yes to overwrite an existing file)
“trash.mbx” should be renamed “trash”

Any other “mbx” files should be renamed as the same name but with the .MBX extension 
removed. For example, “workmail.mbx” would be renamed “workmail”.    The AT&T WorldNet 
Service email software will now recognize these existing email boxes.



Special Cases
This release of AT&T WorldNet Service software includes a 32-bit version of Netscape Navigator 
software version 2.0.    Some users may already have another copy of Netscape Navigator 
software version 2.0 on their PCs, perhaps for use on a LAN (Local Area Network), or installed as 
part of some other software package.    If you want to use both the AT&T WorldNet Service 
software and a separate 32-bit version of Netscape Navigator software together on the same PC, 
please read When You Have More Than One Installation of Netscape Navigator Software 2.0.

If you want to use Netscape Navigator software to access the Internet both over a LAN and via 
AT&T WorldNet Service, see Using Netscape Navigator Software on a LAN.

Finally, if you already have version 1.0 of the AT&T WorldNet Service software installed on this PC,
please see Upgrading From AT&T WorldNet Service 1.0. 



When You Have More Than One Installation of Netscape Navigator Software 2.0
This release of AT&T WorldNet Service software includes a 32-bit version of Netscape Navigator 
software version 2.0.    Some users may already have another copy of Netscape Navigator 
software version 2.0 on their PCs, perhaps for use on a LAN (Local Area Network), or installed as 
part of some other software package.

Although Netscape Navigator 2.0 software can be installed more than once on a PC, all 
installations of the software store their settings in the same place in the Windows 95 Registry.    
Accordingly, changing any of these shared settings for one copy of the program will also change it 
for the others.    The following settings are shared:

    Bookmarks
    Under the “Options” menu:
    General Preferences
    Mail and News Preferences
    Network Preferences
    Security Preferences
    Show Toolbar On/Off
    Show Location On/Off
    Show Directory Buttons On/Off
    Auto Load Images On/Off
    Document Encoding

The settings below must have the correct values for the AT&T WorldNet Service software to work 
correctly.    If you change them in another copy of the 32-bit Netscape Navigator software, you must 
change them back to the values below to use AT&T WorldNet Service:

Mail and News Preferences
These settings can be found under the “Mail and News Preferences” choice in the “Options” menu, on
the “Servers” tab:

    Outgoing Mail (SMTP) Server: mailhost.worldnet.att.net
    Incoming Mail (POP) Server:    postoffice.worldnet.att.net
    Pop User Name: your AT&T WorldNet Service Email ID
    News (NNTP) Server: netnews.worldnet.att.net

Network Preferences - Proxy setting
This setting can be found under the “Network Preferences” choice on the “Options” menu, on the 
“Proxies” tab.

    To connect to AT&T WorldNet Service, “No Proxies” must be selected.

See also:
How to Restore a Previous Configuration

Using Netscape Navigator Software on a LAN



Using Netscape Navigator Software on a LAN
If you use 32-bit Netscape Navigator software to connect to the Internet over a LAN (Local Area 
Network), you should read this section.

The proxy server settings are among those that are shared by multiple installations of Netscape 
Navigator software. These settings can be found by pulling down the “Options” menu, choosing 
the “Network Preferences” item, and then clicking on the “Proxies” tab. 

When you install the AT&T WorldNet Service software, it may set the proxy server value to “No 
Proxies”. If you have a version of the 32-bit Netscape Navigator software configured to use a proxy
server, the value of the proxy setting in that version of Netscape Navigator software will also be set
to “No Proxies”. Further, the names of proxy servers that were entered under the Manual Proxy 
Configuration “View” button may be cleared. If your previous Netscape Navigator software 
installation requires a proxy server to connect to the internet, you will need to re-enter the proxy 
setting values for your Netscape Navigator software to work properly over the LAN.

Conversely, if you configure your Netscape Navigator software to use a proxy server, the AT&T 
WorldNet Service software will also be automatically configured to use that same proxy server. The
proxy setting must be “No Proxies” for the AT&T WorldNet Service software to work properly.

If you switch back and forth between AT&T WorldNet Service (via a dial-up connection) and the 
Netscape Navigator software (via a proxy server on a LAN), you will need to set the proxy settings 
appropriately each time you switch.

See also:
AT&T WorldNet Service prompts me to dial, even though I'm running a different application.
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How to Access AT&T WorldNet Service
AT&T WorldNet Service is configured to autodial (i.e., display the “Connect to” window 
automatically) whenever you want to browse the Internet.    To access AT&T WorldNet Service, just 
perform the following steps:

1. Double-Click on the “AT&T WorldNet Service” icon (in the “AT&T WorldNet Service” folder, or 
on your desktop).

2. A window titled “Connect To” will be displayed. Click on the “Connect” button. You will 
automatically be connected to AT&T WorldNet Service, and the Netscape Navigator software 
will be started automatically.

If you have disabled autodialing, perform the following steps instead:

1. Double-Click on the “Shortcut to AT&T WorldNet” icon (in the “AT&T WorldNet Service” folder,
or on your desktop).

2. A window titled “Connect To” will be displayed. Click on the “Connect” button.

3. Wait for your connection to be established.    This will be indicated by a phrase such as 
“Connected at 24000 bps” in the “Connected to AT&T WorldNet” window.

4. Double-click on the “AT&T WorldNet Service” icon (in the “AT&T WorldNet Service” folder, or 
on your desktop).

Note:  when you are finished using AT&T WorldNet Service, don’t forget to disconnect by 
clicking on the “Disconnect” button in the “Connected to AT&T WorldNet” window.

See also:
How to turn autodialing on and off.
My connection to AT&T WorldNet Service is not being closed automatically when I shut down 
the browser.



How to Install Dial-Up Networking and TCP/IP
You cannot create an account with AT&T WorldNet Service until you have installed Windows 95 Dial-
Up Networking, and added the TCP/IP protocol.      You will need your Windows 95 software installation 
CD or floppy disks to complete this installation.

To install Dial-Up Networking:

1. Click here     to run the Windows 95 Application Wizard.
2. Click on the Windows Setup tab if it is not already selected.
3. Click “Communications” (do not click the check box next to Communications), then click the 
“Details” button.
4. Click to select the Dial-Up Networking check box, then click “OK”.
5. On the Windows Setup tab, click “OK”.    You will be prompted to insert your Windows 95 CD-
ROM or floppies, and Windows 95 will install the components needed to use Dial-Up Networking.

6. You will see a message telling you that you must restart Windows 95 for the changes to take effect.   
However, do not restart Windows 95 yet!    You still need to configure Dial-Up Networking to use 
TCP/IP.

To add TCP/IP:

1. Click here        to bring up the Windows 95 Network Control Panel.
2. On the Configuration tab, click “Add”.
3. Double-click “Protocol”. 
4. Select “Microsoft” from the “Manufacturers” column.    Select TCP/IP from the “Network 
Protocols” column.
5. Click OK.    Windows 95 will install the components needed to use Microsoft’s TCP/IP protocol 
stack.

6. Again, you will see a message telling you to restart Windows 95.    This time, go ahead and 
restart.    When Windows 95 restarts, you may be prompted to enter a login name and 
password.    Do not click “Cancel”!    Enter your name.    If you have never logged in 
before, you can make logging in a one-time procedure, by leaving the password field blank.  
If you leave the password field blank the first time you log in, in the future you will be logged 
in automatically whenever you restart Windows 95.



How to Install the Client for Microsoft Networks
To add the Client for Microsoft Networks:

1. Click here        to bring up the Windows 95 Network Control Panel.
2. On the Configuration tab, click “Add”.    A dialog with the title “Select Network Componenet Type” 
will appear.
3. Select “Client”.
4. Click “Add”.    A dialog with the title “Select Network Client” will appear.
5. Select “Microsoft” from the manufacturers column, and “Client for Microsoft Networks” from the 
network clients column.

6. Click “OK”

7. Click “OK” again.    You will be prompted to supply your Windows 95 CD-ROM or disk.    
Insert it in the appropriate drive and click “OK”.

8. Windows 95 will install the correct software components, and will then prompt you to restart 
your computer.    Click “Yes”.

Once you have completed the installation, the Shutdown menu will include the option “Close all 
programs and log on as a different user”.



How to Turn Autodialing On and Off
AT&T WorldNet Service is configured to AutoDial (i.e., display the “Connect to” window 
automatically) whenever you want to browse the Internet. To turn AutoDial on/off, perform the 
following steps:

1. Right-click on the “AT&T WorldNet Service” icon on the Windows 95 desktop. (Not the “AT&T 
WorldNet Service” shortcut in the “AT&T WorldNet Service” folder!)

2. Select Properties.

3. To turn AutoDial on or off, click on the “Use AutoDial” checkbox (AutoDial is enabled if the box is 
checked, disabled if it is not). When Autodial is enabled, make sure that the drop-down list box 
displays the Dial-Up Networking connection for AT&T WorldNet Service (usually “AT&T WorldNet”).

Note:  when you are finished using AT&T WorldNet Service, don’t forget to disconnect by 
clicking on the “Disconnect” button in the “Connected to AT&T WorldNet” window.

See also:
AT&T WorldNet Service prompts me to dial, even though I  ’  m running a different application.  



How to Uninstall the AT&T WorldNet Service Software
Before uninstalling the software, we recommend that you create a backup of your account 
information.    See How to Back Up Your AT&T WorldNet Service Account Information.    Also, note 
that uninstalling the software will delete the Troubleshooting Guide you are now reading.

To uninstall the AT&T WorldNet Service software, perform the following steps:

1. Click here        to run the Windows 95 Application Wizard.
2. On the “Install/Uninstall” tab, scroll to the “AT&T WorldNet Service 2.0” entry in the list of 
applications. Note: even if you have multiple installations of the AT&T WorldNet Service 2.0 software (i.e., 
in different directories), only one entry will appear in the list of applications.    The Uninstaller will remove 
the AT&T WorldNet Service 2.0 software that you installed most recently.

3. Select the “AT&T WorldNet Service 2.0” entry, and click on the “Add/Remove” button. 

4. After the uninstaller has run, you may see the message: “Uninstall completed.    Some 
elements could not be removed.”    This is because files and other components added after the
original installation process are not automatically deleted.    See Uninstall completed.    Some 
elements could not be removed  if you want to remove these remaining components of the 
AT&T WorldNet Service software.



How to Reinstall the AT&T WorldNet Service Software
If you ever need to reinstall the AT&T WorldNet Service software (for example, if some of the AT&T
WorldNet Service program files are lost or damaged), follow the instructions below.    Before 
reinstalling the AT&T WorldNet Service software, we recommend that you exit all Windows 
applications. Also, you must close your Dial-up Networking folder, if it is open.    If it is left 
open, the Dial-Up Networking connection may not get created.    (See The Account Setup Wizard 
did not create a   “  Shortcut to AT&T WorldNet  ”   icon.    )

1. After you have closed all Windows applications and your Dial-up Networking folder, click here  
to run the Windows 95 Application Wizard.

2. On the Install/Uninstall tab, click on the “Install” button.
3. Follow the instructions on the wizard with the title “Install Program From Floppy Disk or CD-
ROM”. Insert the AT&T WOrldNet software media in the appropriate drive, and click “Next”. The wizard 
will automatically find the setup.exe program.

4. Click “Finish”.    The AT&T WorldNet Service software will be started for you.

Follow the onscreen installation instructions. You will see a window that asks you where to install 
the AT&T WorldNet Service software.    Install the software in the same directory that it currently 
resides in (usually C:\PROGRAM FILES\WORLDNET).

Note: Even though you will see a window instructing you to double-click on the “Double Click 
to Set Up Account” icon, there is no need to re-register with the AT&T WorldNet Service.    Once 
installation is complete, you have finished reinstalling the software.



How to Find AT&T WorldNet Service Local Access Numbers
You can look up local access numbers while connected to AT&T WorldNet Service.    Click on either the
“AT&T WorldNet” or “Member Services” button, and look for references to “Access Numbers” or 
“General Information”.

If you are unable to locate a local access number that meets your needs, you can also access 
AT&T WorldNet Service at +1 (800) KID-EASY (+1 (800) 543-3279),    but extra charges will apply.  
Contact AT&T WorldNet Service Customer Care for current rates.



How to Back Up Your AT&T WorldNet Service Account Information
Once you have registered with AT&T WorldNet Service and created your account, click here        to 
run the AT&T WorldNet Service account access tool.    This tool will generate a file containing the 
information and instructions you need to recreate your AT&T WorldNet Service account on this PC 
if it is ever deleted, or the configuration information is damaged.    Print out the file, or copy it to a 
floppy, and keep it in a safe place.

This tool will only run successfully on the PC which was originally used to register with AT&T 
WorldNet Service.    If you attempt to run it on another PC configured to use the same account, you
will get the message “Could not find/read the configuration file.”

Important: The information and instructions generated by the account access tool should be 
handled with great care and kept in a secure place, since anyone with access to them can also get
access to your AT&T WorldNet Service account.



How to Use Your AT&T WorldNet Service Account On More Than One PC
Once you have registered with AT&T WorldNet Service and created your account, click here        to run 
the AT&T WorldNet Service account access tool.    This tool will generate a file containing the 
information and instructions you need to recreate your AT&T WorldNet Service account on another PC.

This tool will only run successfully on the PC which was originally used to register with AT&T WorldNet 
Service.    If you attempt to run it on another PC configured to use the same account, you will get the 
message “Could not find/read the configuration file.”

Important: Note that although you can use a single account on more than one PC, additional 
charges apply if the account is being used to access AT&T WorldNet Service from more than 
one PC concurrently.    In other words, if more than one PC is connected to AT&T WorldNet Service 
using the same account at the same time, extra charges will apply while the additional PCs are 
connected.    Be sure to consult the AT&T WorldNet Service Terms and Conditions (click on the 
Member Services button on the browser, and then look under General Information), or contact AT&T 
WorldNet Service Customer Care for more information.

Also, remember that the information and instructions generated by the account access tool should be 
handled with great care and kept in a secure place, since anyone with access to them can also get 
access to your AT&T WorldNet Service account.



How to Enable Windows 95 User Profiles
If you received the message “When using the Internet, Windows 95 requires users to log on to their 
computers. . .”    when you run the Account Setup wIzard, and you do not see the option “Close all 
programs and log on as a different user” when you shut down Windows 95, logging on is not enabled 
on your PC.    You can enable logon by either installing the Client for Microsoft Networks, or by enabling
Windows 95 user profiles.    The preferred approach is generally to install the Client for Microsoft 
Networks, because it usually has less impact on the behavior of your PC.

If you choose to enable Windows 95 User Profiles, you may see some differences in how your 
computer behaves.    In particular, if you log on as different users at different times, you may see 
different desktop icons, network neighborhood elements, start menu settings, and program groups.

To enable Windows 95 User Profiles:

1. Click here        to bring up the Windows 95 Password Control Panel. 
2. Click on the “User Profiles” tab if it is not already selected.
3. Click “Users can customize their preferences and desktop settings”, and click OK. 
4. Restart your computer.

You will then be asked to log on when Windows 95 starts.    You can leave the password field blank if 
you prefer.



How to Adjust Your Modem and COM Configuration
Some older PCs can experience performance problems because they use an 8250    UART (Universal 
Asynchronous Receiver/Transmitter) chip rather than the newer 16550.    The UART chip serves as the 
intermediary between the PC and the modem, and the 8250 can have problems keeping up with 14.4 
kbps or faster modems.    When this is the case, the overall performance of the connection degrades 
considerably.    Sometimes the situation can be improved considerably by adjusting the modem 
properties.    To give this a try:

1. Click here        to bring up the Windows 95 Modem Wizard.
2. Click on the “Diagnostics” tab.
3. Highlight the COM port with your modem on it.
4. Click the “More Info. . .” button. Windows 95 will run some tests on your modem, and then 
display them in a window with the title “More Info. . . “. In this window, the top box is labeled “Port 
Information”.    If the UART is a type with “8250” in the name, procede to step 5. If the UART is a type 
with “16550” in the name, this is unlikely to be the source of your problems.    Click “OK” to close the 
“More Info” window, and then “Close” to close the Modem Wizard.

5. If you have determined that you have an 8250-type UART, you may improve performance and 
reliability by adjusting the modem properties.    Click on the “General” tab of the “Modems 
Properties” dialog.

6. Highlight the modem you are using to dial in to AT&T WorldNet Service.

7. Click the “Properties” button.    A properties dialog for your specific modem will appear.

8. On the “General” tab of your modem’s properties dialog, try setting the Maximum speed value to a 
lower number.    Setting this value to 38400 or 19200 will sometimes improve the overall 
performance of your computer on the network.

9. Click OK to close your modem’s properties dialog.

10. Click “Close” to close the Modem Wizard.



How to Recover if You Forget your Windows 95 Password
If you’ve forgotten your Windows 95 password, you can create a new one by deleting or renaming your
password list file (.pwl) in the Windows folder.    The file is named <Username>.pwl, where 
<Username> is the name you use to log on.    Once you’ve done this, you can restart Windows 95, and
log on as that user with whatever password you want.    You can leave the password field blank the first
time you log in, and Windows 95 will automatically log you in as that user the next time it starts up, 
without asking you.

Warning:    If you are on a LAN and delete this .pwl file, you will lose saved passwords for LAN 
resources.    After rebooting, you will be prompted to reenter them when you reconnect to those 
resources.



How to Recover if You Lose Your AT&T WorldNet Service Network Access User Name or 
Password
The user name and password information used in the Dial-Up Networking connection to AT&T 
WorldNet Service is available in the backup account information file. The email user ID and 
password are also available in this file.

The Network Access user name and password can be typed in to the AT&T WorldNet Dial-Up 
Networking connection.    Note that Windows 95 will not save the password until the connection 
has been used to log in successfully.

See also:
How to Back Up Your AT&T WorldNet Service Account Information
I  ’  m Confused about Passwords and Logins  



How to Enter the AT&T WorldNet Service DNS address

1. Click here        to bring up the Windows 95 Network Control Panel.
2. On the Configuration tab, select “TCP/IP->Dial-Up Adapter” and click “Properties”.    A dialog will 
come up with the title “TCP/IP Properties”.
3. Select the DNS Configuration tab.
4. Look at the list of addresses under DNS Search Order.    If one or both of the AT&T WorldNet 
Service DNS server addresses (204.127.129.1 and/or 204.127.160.1) are already on the list, there is no 
need to add them again.    Click “Cancel”.    Otherwise, go on to step 5.

5. You can specify up to three DNS server addresses in Windows 95.    If you have fewer than three 
DNS server entries, skip to step 6.    If there are already three, you will need to remove one of the 
addresses before you can add the AT&T WorldNet Service address. To remove a DNS entry, click 
on the entry you want to remove, and then click on the “Remove” button.    If your PC is on a Local
Area Network, consult your network administrator before removing a DNS entry.    Before you 
remove an address, make sure you write the address down so that you can add it back later, if 
necessary.

6. Enter 204.127.129.1 (the AT&T WorldNet Service DNS) in the DNS Search Order field, and then 
click Add.    If you can add another, add 204.127.160.1, the AT&T WorldNet Service Secondary DNS.

7. Click OK.

8. Click OK again.    You will see the message “You must restart your computer before the new settings
will take effect.    Do you want to restart your computer now?”

9. Restart your computer.



How to Disable Your DNS Configuration
WARNING: If you disable DNS, all of the DNS entries will be cleared by Windows 95 when 
you restart your computer. You should write the addresses down, so that you can add 
them again later, if necessary. If you're on a Local Area Network (LAN), consult your 
network administrator before disabling DNS.

To disable DNS:

1. Click here        to bring up the Windows 95 Network Control Panel.
2. On the Configuration tab, select TCP/IP->Dial-Up Adapter in the list (you might have to scroll), 
and then click Properties.
3. Select DNS Configuration.
4. Make sure you have read and understood the warning above!
5. Click Disable DNS, and then click OK.
6. Close all the open dialog boxes by clicking OK.
7. Restart your computer and try connecting again.



How to Restore a Previous Configuration
When you install the AT&T WorldNet Service software, it looks for any previous installation of the 
Netscape Navigator software for Windows 95.    If it finds any, it saves a copy of the relevant part of the 
Windows 95 registry in a file called “previous.reg”, in the AT&T WorldNet Service install directory 
(usually C:\Program Files\WorldNet).    After you have registered with AT&T WorldNet Service, another 
copy of that part of the Windows 95 registry is saved in a file called “worldnet.reg”, in the same 
directory.

The information in this part of the registry includes most of the preferences and settings that are visible 
from the Netscape Navigator software’s “Options” menu.    It does not include the actual programs or 
data files, and it does not include the Dial-Up Networking connections.    (See When You Have More 
Than One Installation of Netscape Navigator Software 2.0 for more information.)    If you later decide 
you want to revert back to the earlier registry values, you can use these files to restore most of your 
previous configuration.    Some information like previous bookmarks may or may not be restored, 
depending on exactly how your Netscape Navigator software was configured.

To restore the previous configuration:

1. Click on the “Start” button on the Windows 95 taskbar.

2. Select “Run”.

3. Type the following command    (see Note below):
regedit “C:\Program Files\WorldNet\previous.reg” 

4. Click “OK”.    You should see a message box with the text “Information in C:\Program Files\
WorldNet\previous.reg has been successfully entered into the registry.”

Note several points about the command in step 3:
n If necessary, substitute the appropriate installation directory for C:\Program Files\Worldnet.
n Substitute worldnet.reg for previous.reg if you want to restore the post-registration software settings.
n Do not omit the quotation marks around the full path name.

Important:    If you restore these pre-existing registry settings, you will overwrite your current AT&T 
WorldNet Service software preferences, and you may lose changes made since the “previous.reg” and
“worldnet.reg” files were created.



Troubleshooting

I  ’  m confused about passwords and logins.  

I  ’  m having difficulty dialing out.  

The Account Setup Wizard did not create a Shortcut to AT&T WorldNet icon. 

I can't connect to the Registration server to set up my account. 

Dial-Up Networking seems to have lost my password.

I can't get my Email.

I can  ’  t get my News.  

AT&T WorldNet Service prompts me to dial, even though I'm running a different application. 

While connected to the Internet, I'm suddenly cut off.

My connection to AT&T WorldNet Service is not being closed automatically when I shut down the 
browser. 

Web pages that change frequently don't load properly.

It's taking too long to download pages from the web.

Messages: 

An existing installation of Netscape Navigator software has been found on your machine.    Your 
preferences have been saved.

A required .DLL file c:\windows\system\svrapi.dll was not found..

Could not add WorldNet DNS address.

ERROR PPP NO PROTOCOL

Internal Authentication error.

Netscape is unable to locate the server: www.worldnet.att.net.

The computer you are dialing in to cannot establish a Dial-Up Networking connection.    Check your 
password, and then try again. 

The modem is being used by another Dial-Up Networking connection or another program. 

The modem is not plugged in or is out of service.

The server does not have a DNS entry.

Unable to negotiate dial-in connection.

Uninstall completed.    Some elements could not be removed.

Uninstaller Version Number Not Available

When using the Internet, Windows 95 requires users to log on to their computers. . .

You must install Windows 95 Dial-Up Networking before registering.

Your system is enabled for another Domain Name System (DNS) server.
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I'm Confused About Passwords and Logins
As a user of AT&T WorldNet Service, you have two sets of passwords and logins.    (Logins are also 
referred to as user names or user IDs.)    One set is the email login and password, which you chose 
when you created your AT&T WorldNet Service account.    This set is used only when you connect to 
the AT&T WorldNet Service email facilities, either to send or receive mail.

The other set was created automatically for you when you registered with AT&T WorldNet Service, and 
is referred to here as your network access user name and password.    This user name and password 
are used in the Windows 95 Dial-Up Networking connection to allow you to connect to AT&T WorldNet 
Service. The network access username has a value like:

123456789@worldnet.att.net
and the network access password has a value like:

 !@#$%^&*()_+QWER

Don’t try to use your email login and password for network access, and don’t try to use your network 
access user name and password to send or receive email!

See also:
Dial-Up Networking Seems to Have Lost My Password



I’m Having Difficulty Dialing Out
Under some conditions, other applications that dial out using your modem may already be using 
the communications port or modem when you try to connect to AT&T WorldNet Service.    When 
this occurs, you will typically see the message “The modem is being used by another Dial-Up 
Networking connection or another program.    Disconnect the other connection or close the 
program, and then try again.”

Some types of applications that may be using the communications port are:
 Another Internet service provider's dialer program
 An online service, such as America Online
 PC fax programs, especially if configured to autoreceive
 Terminal programs, such as Windows Hyperterminal
 Dialup E-mail programs, such as AT&T Mail Access PLUS or Microsoft Exchange.

If you see a message telling you that the communications port is busy, or you simply cannot dial 
out, try the following:

1. Close any applications that you think may be blocking access to the communications port.    
(You can see a list of running Windows 95 applications by pressing the ctrl-alt-delete key 
combination one time.    If you press this a second time, it will restart your PC.)

2. If closing the application(s) does not fix the problem, try resetting the modem. If you have an 
external modem, turn it off and then back on. If this does not fix the problem (or you have an 
internal modem) we recommend that you shut down Windows, and turn your PC off and back 
on. This should reset the modem.



The Account Setup Wizard did not create a "Shortcut to AT&T WorldNet" icon
If the Dial-up Networking folder on your desktop is open when you run the Account Setup Wizard, 
the shortcut to the AT&T WorldNet Dial-up connection does not get created. The Dial-up 
networking connection itself may also fail to appear in the Dial-up Networking folder. If you close 
and re-open the Dial-up Networking folder, the AT&T WorldNet Dial-up connection should appear.

After you have an AT&T WorldNet Dial-up connection, you can create a shortcut to it by performing
the following steps:

1. Open the Dial-up Networking folder (if it is not already open).

2. Using the right mouse button, drag a copy of the AT&T WorldNet connection to the desired 
location (desktop or folder).

3. Select    the “Create Shortcut(s) Here” option from the pop-up menu.

If you are still unable to make the Dial-Up Networking connection appear, please call AT&T 
WorldNet Service Customer Care.



I can't connect to the Registration server to set up my account.
The Registration server might be busy or temporarily not accepting calls. Wait a moment and try 
again.



Dial-Up Networking Seems to Have Lost My Password.
Your Dial-Up Networking password can seem to disappear for several reasons:

            First, it will disappear if you rename a Dial-Up Networking connection.    If you did this, your 
password really will be gone.    See How To Recover If You Lose Your AT&T WorldNet Service 
Password.

            Second, it will disappear if you uncheck the “save password” box on the connection screen.    If you
did this, your password really will be gone.    See How To Recover If You Lose Your AT&T WorldNet 
Service Password
            Third, it will -seem- to disappear if you are not logged in to Windows 95 as the same user that 

originally registered with AT&T WorldNet Service.

This third item requires some explanation.    The behavior of Dial-Up Networking changes in some 
important ways, depending on whether or not a user logged on to the PC.    If you log on to your PC 
sometimes as one user and other times as another, or sometimes click the “Cancel” button on the 
logon screen instead of actually logging on, you may see confusing behavior.    Specifically, some Dial-
Up Networking phone book entries may seem to disappear, passwords may seem to be lost, the “Save
password” checkbox in the Dial-Up Networking connection may be greyed out (disabled), and so forth.
To make a long story somewhat shorter:

            Dial-Up Networking will not save your AT&T WorldNet Service password if it does not know who 
you are.

            The only way it can know who you are is if you log on to Windows 95 on your PC. 
            The only user who is allowed to make use of a saved Dial-Up Networking password is the one who 
was logged in when it was first saved.

The best approach is to make sure you are logged on to Windows 95, and always log on as the same 
Windows 95 user whenever you want to access AT&T.    To force a log on:

1. Close any other applications that are currently running.

2. Click on the Start button on the Windows 95 task bar.

3. Select “Shut Down. . .”.

4. Select the option “Close all programs and log on as a different user.”    (Note:    if you are not offered 
this as an option, you do not have the Client for Microsoft Networks installed.    In order to log in, you
must either install the Client for Microsoft Networks, or enable Windows 95 User Profiles.    See How
to Install the Client for Microsoft Networks and How to Enable Windows 95 User Profiles.)

5. Click on the “Yes” button.

Windows 95 will then restart, and will prompt you to enter a login name and password.    Enter your 
name.    Don’t click cancel at the login screen.    If you don’t want to log in because you’re afraid of 
forgetting your password, you can leave the password field blank.    If you install the Client for Microsoft
Networks rather than enabling User Profiles, and you leave the password field blank, you will be 
logged in automatically whenever you restart Windows 95.

If you’ve forgotten your Windows 95 password, see How to Recover if You Forget Your Windows 95 
Logon Password.

If you want to be asked to log on every time you start Windows 95, you can enable the Windows 95 
User Profiles feature.    See How to Enable Windows 95 User Profiles.

If you log on as the same Windows 95 user that originally registered with AT&T WorldNet Service, and 



you still cannot use your AT&T WorldNet Service connection, see How to Recover if You Lose Your 
AT&T WorldNet Service Password.



I can't get my email.
Make sure that you have the correct mail server addresses. They are:

 SMTP server address: mailhost.worldnet.att.net
 POP server address:    postoffice.worldnet.att.net

To verify that these values are correct:
1. Start the AT&T WorldNet Service browser

2. Click Options.

3. Click Mail and News Preferences

4. Click the Servers page tab. Check the SMTP and POP server information entered there. Also be 
sure that the value in the “Pop User Name” field (i.e., your email ID) is correct.    Change the 
information if it isn't correct, and click OK.

If this does not fix the problem, please call AT&T WorldNet Customer Care.



I can't get my News.
Make sure that you have the correct news (NNTP) server address.    This is:

 netnews.worldnet.att.net

To verify that this value is correct:
1. Start the AT&T WorldNet Service browser.

2. Click Mail and News Preferences

3. Click the Servers page tab. Check the News (NNTP) server information at the bottom of the window.
Change the value if it isn't correct, and click OK.

If this does not fix the problem, please call AT&T WorldNet Customer Care.



AT&T WorldNet Service prompts me to dial, even though I'm running a different application.
At installation time, AT&T WorldNet Service software is configured to autodial by default.    If you leave 
autodial enabled, you will be prompted to connect to AT&T WorldNet Service when other TCP/IP 
applications attempt to establish a Dial-Up connection. If you do not want to connect to AT&T WorldNet
Service, click on the “Cancel” button in the “Connect To” window.

You may also be prompted to connect to AT&T WorldNet Service when one of the applications on your 
PC attempts to establish a TCP/IP connection over a LAN (Local Area Network).    Again, simply click 
on the “Cancel” button in the “Connect To” window, and the application will connect over your LAN.

If you want to turn off autodialing, see How to Turn Autodialing On and Off.



While connected to the Internet, I'm suddenly cut off.
If you have Call Waiting on your phone line, make sure it’s disabled.    To disable Call Waiting, 
perform the following steps:

1. Double-Click on the “Shortcut to AT&T WorldNet” icon (in the “AT&T WorldNet Service” folder,
or on your desktop).

2. A window titled “Connect To” will be displayed. Click on the “Dial Properties…” button.

3. Check the box that reads, “This location has call waiting. To disable it, dial:” if it is not already 
checked.

4. Select or type the appropriate dialing prefix to disable your call waiting in the listbox.    To get a 
list of choices, click on the down arrow. 

You can also be suddenly cut off if someone in your home picks up a phone on the same line while 
you're connected.    Also, sometimes sudden disconnection can be a symptom of modem and 
communications port configuration problems.    See    How To Adjust Your Modem and COM 
Configuration.



My connection to AT&T WorldNet Service is not being closed automatically when I shut down 
the browser.
The Netscape Navigator software included with AT&T WorldNet Service software does not 
automatically disconnect you from the service when you close it. However, you can set up the software
to Auto Disconnect after some period of idle time (i.e., time during which there are no transactions over
your AT&T WorldNet connection). The default setting for Auto Disconnect is 20 minutes. To change this
setting, perform the following steps:

1. Right-click on the “AT&T WorldNet Service” icon on the Windows 95 desktop. (Not the “AT&T 
WorldNet Service” shortcut in the “AT&T WorldNet Service” folder!)

2. Select “Properties”.

3. To turn Auto Disconnect on or off, click on the “Auto disconnect” checkbox (Auto Disconnect is 
enabled if the box is checked, and disabled if it is not). When Auto Disconnect is enabled, type the 
value in the “Disconnect if idle” field.



Web pages that change frequently don't load properly
Because of the way that this version of the Netscape Navigator software handles Daylight Saving 
Time, certain web pages that change content more frequently than once an hour may not load properly.
The problem occurs when the user tries to reload the page.    When Daylight Saving Time is in effect, if 
the page has changed during the last hour, the new version of the page will not be loaded.

If you encounter this problem, the best workaround is to modify a Windows 95 setting to let Netscape 
Navigator know that your PC already handles Daylight Savings Time on its own.    To do this, you must 
first determine the appropriate value, depending on the time zone in which you are using your PC.    
The appropriate values are:

EDT04
CDT05
MDT06
PDT07

and so forth for other time zones. The first three characters give the abbreviation for your time zone 
(Eastern Daylight Time, Central Daylight Time, etc) and the next two digits give the number of hours 
difference between your time zone and Greenwich Mean Time. Note that the fourth character is a zero,
not an “O”.

To set this value, put the following line into your PC’s AUTOEXEC.BAT file:
SET TZ=CDT05

substituting for CDT05 as appropriate.    You will have to reboot your PC for the change to take effect.



It's taking too long to download pages from the web.
There are numerous reasons why it may take a long time for a web page to download.    Parts of 
the web outside of AT&T WorldNet Service are prone to “traffic jams” due to high demand, network
bottlenecks, and/or slow server computers.

Frequently a download will seem slow because the page being received contains a lot of data in 
the form of images.      To speed things up, you can uncheck the Auto Load Images item in the 
Options menu of the Netscape Navigator software.    When this item is unchecked, regular text on 
the page is displayed as before, but images on the page are displayed as small icons.    By clicking
on one of the small icons, you can cause the corresponding image to be downloaded.    To load all 
the images on the page, click on the “Images” button on the toolbar.

Also, some performance problems can be symptoms of modem and communications port configuration
problems.    See    How To Adjust Your Modem and COM Configuration.



“An existing installation of Netscape Navigator software has been found on your machine.    
Your preferences have been saved.”
This message is displayed if another copy of 32-bit Netscape Navigator software is detected during the
installation of the AT&T WorldNet Service software.    When this occurs, a copy of the Windows 95 
registry entries for your previous installation of Netscape Navigator software are saved in a file 
“previous.reg”, in the AT&T WorldNet Service install directory (usually C:\Program Files\WorldNet).    If 
you later decide you want to revert back to the earlier Netscape Navigator software version, you can 
use this file to restore most of your previous configuration information. 

See also How to Restore a Previous Configuration. 



“A required .DLL file c:\windows\system\svrapi.dll was not found.”
This error will occur if you don't have Dial-Up Networking set up before trying to use the Account
Setup Wizard. To set up Dial-Up Networking:

1. Click here  to bring up the Network Control Panel.
2. On the configuration tab, click Add.
3. Select Adapter in the list, and then click Add.
4. Select Microsoft in the Manufacturers list. Select Dial-Up Adapter in the Network Adapters list, 
and then click OK.

You must restart your computer before the new settings will take effect. After you restart, try using the 
Account Setup Wizard again.



“ERROR_PPP_NO_PROTOCOL”
This error will occur if you have not selected TCP/IP as the network protocol for your dial-up 
adapter. You can reinstall AT&T WorldNet Service (TCP/IP should be installed automatically). 
With your Windows 95 CD or diskettes in hand, you can also install TCP/IP yourself by 
performing the following steps:

1. Click here  to bring up the Network Control Panel.
2. On the Configuration tab, click Add.
3. Select Protocol, and click Add.
4. Select Microsoft as the manufacturer and TCP/IP as the protocol.
5. Click OK. 



“Internal Authentication error.”
This error will occur if you haven't selected a dial-up adapter.

1. Click here  to bring up the Network Control Panel.
2. On the Configuration tab, click “Add”.
3. Select Adapter, and click “Add”.
4. Select Microsoft as the manufacturer and Dial-Up Adapter as the Network Adapter.
5. Click “OK”



“Netscape is unable to locate the server: www.worldnet.att.net. The server does not have a DNS
entry. Check the server name in the Location (URL) and try again."
This message can occur for several reasons.    It may occur if you start up the AT&T WorldNet 
Service software but have disabled autodial and have not connected to AT&T WorldNet Service, 
or have not waited for the connection to be completely established before starting the browser.

It may also occur because your Proxy settings (under the “Network Preferences” item on the 
“Options” menu) are not correct. This is likely to be the case if you sometimes use the Netscape
Navigator software to access the Internet via a LAN, and other times dialing up via AT&T 
WorldNet Service, and have inadvertantly left the software configured to use a proxy. Go to the 
“Options|Network Preferences” menu, select the Proxies tab, and verify that it is set to “No 
Proxies”.

Finally, you may also see this message if you have a pre-existing DNS address configured in 
Windows 95, or the AT&T WorldNet Service DNS address was entered incorrectly. If you can log
on to AT&T WorldNet Service successfully but repeatedly get this message when trying to 
connect to www.worldnet.att.net, this is likely to be the source of your problems.    This is also 
particularly likely if you received the message Could not add WorldNet DNS address.after 
registration was completed.    See How to enter the AT&T WorldNet Service DNS address. for 
instructions on how to manually enter the AT&T WorldNet Service DNS address.

Important: If you're on a Local Area Network (LAN), ask your network administrator how to 
handle a previous DNS configuration.



The computer you are dialing in to cannot establish a Dial-Up Networking connection.    Check 
your password, and then try again.
This message typically occurs if either:

    You created your AT&T WorldNet Service account while logged in to Windows 95 as one user, and are 
now have either not logged in to Windows 95 at all (by clicking Cancel at the logon prompt) or have 
logged on as a different user.

or:
    You have somehow modified or deleted the User Name or Password in the AT&T WorldNet Dial-Up 
Networking connection.

See Dial-Up Networking Seems to Have Lost My Password.  for information on how to recover.

Also, if you see this message the first time you try to connect to AT&T WorldNet Service, it may be 
because you gave an invalid credit card number when you first signed up for AT&T WorldNet Service.   
If you think this may be the case, contact AT&T WorldNet Service Customer Care for help.

Finally, you may see this message after running the Windows 95 Internet setup wizard.    The Internet 
setup wizard drops “.att.net” from your network access user name for some reason, so that

987654321@worldnet.att.net
will be shortened to:

987654321@worldnet
By simply typing the “.att.net” back onto the end of the user name field in the Dial-Up Networking 
connection, you can restore your ability to connect.



“The modem is not plugged in or is out of service.”
First, make sure your modem is connected to your computer, plugged in, and turned on. 

You'll also see this message when you haven't selected the correct modem in the Account Setup
Wizard. To select the correct modem:

1. Double-click on the My Computer icon on your desktop.

2. Double-click on the Dial-Up Networking folder (you might have to scroll the window).

3. Right-click on the “AT&T WorldNet” connection, and choose Properties on the menu.

4. Check that the modem that appears in the “Connect using:” box is correct. If it is not, select the 
correct modem from the drop-down list. 

5. If this does not fix the problem, or you cannot find the correct modem in the list, click here        to run 
the Windows 95 Modem Wizard.

6. Repeat steps 1-4 to verify that the modem you just installed via the Modem Wizard appears in the 
“Connect using:” box. 



“The server does not have a DNS entry.”
The possible causes for this message include the following:

The URL you are trying to reach is busy. Wait a moment and try again. If this happens repeatedly,
try connecting during off-peak hours.

The server you're looking for doesn't exist. Double check the spelling of the URL and try again.
The server you are trying to reach is temporarily out of service. Try again later.
Your Proxy settings (under the “Network Preferences” item on the “Options” menu) may not be 

correct. To access the AT&T WorldNet Service, you should select “No Proxies”.
Try another URL. If you keep getting this message when you try other URLs, you might have 

problems with your DNS configuration. If you can log on to AT&T WorldNet Service successfully but 
repeatedly get this message when trying to connect to www.worldnet.att.net, your DNS configuration likely
to be the source of your problems.    This is particularly true if you received the message Could not add 
WorldNet DNS address.after registration was completed.    See How to enter the AT&T WorldNet Service 
DNS address. for instructions on how to manually enter the AT&T WorldNet Service DNS address.

Important: If you're on a Local Area Network (LAN), ask your network administrator how to handle a 
previous DNS configuration.



“Unable to negotiate dial-in connection.”
You may be experiencing line noise or cable problems.    Check your connections, and try connecting 
again in a few moments.    If you continue to have this problem, you may need to check your modem 
configuration.    See How to Adjust Your Modem and COM Configuration.

If you continue to get this error, please contact AT&T WorldNet Service Customer Care.



“Uninstall completed.    Some elements could not be removed.    You should manually remove 
items related to the application.”
You may see a message informing you that the Uninstaller could not remove all of the components of 
the AT&T WorldNet Service software.    If this occurs, you will need to remove the remaining 
components manually.    See below for a description of the items that may not be completely removed, 
and how to remove them:

 The AT&T WorldNet Service software installation directory
The Uninstaller may not remove all of the subdirectories/files in the AT&T WorldNet Service software 
installation directory (usually C:\PROGRAM FILES\WORLDNET). 

Important:    If you delete the AT&T WorldNet Service software installation directory, you will 
delete all files in the AT&T WorldNet Service software installation directory.    Be certain that you
do not have any other applications or files under that directory before proceeding.
You can delete the directory and its subdirectories by performing the steps below.    

1. Open Windows Explorer or File Manager.

2. Select the AT&T WorldNet Service software installation directory (usually C:\PROGRAM FILES\
WORLDNET).

3. Select the “Delete” option from the “File” menu.

 The “AT&T WorldNet Service” folder and “Shortcut to AT&T WorldNet” icon
Under some conditions, the “AT&T WorldNet Service” folder and the “Shortcut to AT&T WorldNet” icon
may be left on your desktop.

If the uninstaller did not remove the “AT&T WorldNet Service” folder, remove it by right-clicking on the 
folder icon in the upper left corner of the “AT&T WorldNet Service” folder window, and selecting 
“Delete” from the resulting pop-up menu. 

To remove the “Shortcut to AT&T WorldNet” icon, right-click on the icon, and select “Delete” from the 
resulting pop-up menu.

 The AT&T WorldNet Dial-Up connection
To remove the AT&T WorldNet Dial-Up connection, perform the following steps:

1. Double-click on the “My Computer” icon.

2. Double-click on the “Dial-Up Networking” folder.

3. Right-click on the “AT&T WorldNet” connection.

4. Select the “Delete” option.

 The AT&T WorldNet Service DNS entry
To remove the AT&T WorldNet Service DNS entry, perform the following steps:

1. Click here        to bring up the Network Control Panel applet.
2. On the Configuration tab, select TCP/IP->Dial-Up Adapter in the list, and then click Properties.
3. Select DNS Configuration.    If the entry 204.127.129.1 (the AT&T WorldNet Service DNS) is not in
the “DNS Server Search Order” list, you are done, and you can close all of the open dialog boxes by 
clicking OK.    If the entry is in the list, click on it, and then click on the “Remove” button.    Important:    If 
you remove the AT&T WorldNet Service DNS, and there are no other entries left in the list, verify that the 
“Disable DNS” radio button is selected before proceeding.    If it is not selected, click on it to select it.



4. Close all the open dialog boxes by clicking OK.    Restart your computer.



“Uninstaller Version Number Not Available”

If you run the Uninstaller once, and then try to run it a second time, you may see the message, 
“Uninstaller Version Number Not Available”. This is a known limitation of the uninstaller.



“You must install Windows 95 Dial-Up Networking before registering.”
The AT&T WorldNet Service software requires Windows 95 Dial-Up Networking and TCP/IP to be 
installed.    See How to Install Windows 95 Dial-Up Networking and TCP/IP.



“When using the Internet, Windows 95 requires users to log on to their computers.    If you have 
a logon, please restart the computer and enter it.”
If you see this message, you are not logged on to Windows 95.    To log on:

1. Close any other applications that are currently running.

2. Click on the Start button on the Windows 95 task bar.

3. Select “Shut Down. . .”.

4. Select the option “Close all programs and log on as a different user.”      (If you are not offered this 
option, see the note below.)

5. Click on the “Yes” button.

Windows 95 will then restart, and will prompt you to enter a login name and password.    Do not click 
“Cancel”!    Enter your name.    If you have never logged in before, you can make logging in a one-time
procedure, by leaving the password field blank.    If you leave the password field blank the first time you
log in, in the future you will be logged in automatically whenever you restart Windows 95.

If you log on to your machine with different user names at different times, you will run into strange 
behavior with Windows 95 Dial-Up Networking passwords.    See Dial-Up Networking Seems to Have 
Lost My Password. 

Note:    if you are not offered “Close all programs and log on as a different user” as an option, you do 
not have the Client for Microsoft Networks installed.    In order to log in and complete the registration 
process, you must either install the Client for Microsoft Networks, or enable Windows 95 User Profiles. 
See How to Install the Client for Microsoft Networks and How to Enable Windows 95 User Profiles.



“Your system is enabled for another Domain Name System (DNS) server.    You might need to 
edit your DNS configuration.    Read the Troubleshooting Guide before you set up your 
account.”
If this message appears when you start the registration wizard, your Windows 95 networking software 
appears to be already configured for use with some other TCP/IP-based network software using the 
Domain Name System.    You do not need to do anything to your configuration unless you also receive 
the message “Could not add AT&T WorldNet Service DNS address”    at the end of registration or 
upgrade. If that message is displayed, you may need to manually edit your DNS configuration.    See 
Could not add AT&T WorldNet Service DNS address.
 
Note: Because of the way DNS works, you may be able to use your existing DNS configuration to 
access AT&T WorldNet Service even if the “Could not add AT&T WorldNet Service DNS Address” 
message is displayed.    We recommend that you go ahead and see if you can successfully connect to 
AT&T WorldNet Service and browse before changing your DNS configuration.



“Could not add AT&T WorldNet Service DNS Address”
This message appears specifically when your dial-up adapter has DNS enabled, and is already 
configured with the Windows 95 maximum of three different DNS server addresses specified.    
Important: If you see this message, you may need to replace one of the existing entries with the AT&T 
WorldNet Service DNS address (see How to enter the AT&T WorldNet Service DNS address) or 
disable DNS (see How to disable your DNS configuration) before you will be able to access AT&T 
WorldNet Service.

Note: Because of the way that DNS works, you may be able to use your existing DNS configuration to 
access AT&T WorldNet Service even if the “Could not add AT&T WorldNet Service DNS Address” 
message is displayed.    We recommend that you go ahead and see if you can successfully connect to 
AT&T WorldNet Service and browse the web before changing your DNS configuration.



If You Still Need Help
You can contact AT&T WorldNet Service Customer Care 24 hours a day, 7 days a week at

1-800-400-1447

Before you call, check out not only the topics covered in this Troubleshooting Guide  , but also the 
numerous other sources of information and help available to AT&T WorldNet Service users:

 The button on the AT&T WorldNet Service browser labeled Member Services will take you to the 
Member Service page on the AT&T WorldNet Service web site.    The Where To Get More Help item 
under the Help menu will take you to the same place.    Here you will find up-to-date information and 
advice about troubleshooting, local access numbers, accounts and billing, software updates, shareware, 
safe family use of the Internet, and much more.

    Also under the Help menu, the Netscape Navigator Handbook is a goldmine of information about 
both basic and advanced features of the the AT&T WorldNet Service browser.



A Brief Glossary of Internet Terminology
This glossary is included to provide reassurance to new users who are intimidated by some ot the 
technical terminology surrounding the Internet.    The definitions and descriptions here are intended to 
be helpful to novices, and thus are not always precise or complete.
DNS (Domain Name System) 
DNS Address
Domain Address
Email Address
FTP (File Transfer Protocol) 
Home Page
HTML (HyperText Markup Language) 
HTTP (HyperText Transfer Protocol) 
Hypertext 
IP Address
LAN (Local Area Network) 
Netnews
Post Office 
Protocol
Proxy
SMTP (Simple Mail Transfer Protocol) 
TCP/IP (Transmission Control Protocol/Internet Protocol) 
URL (Universal Resource Locator)
WWW (World Wide Web) 



DNS (Domain Name System)
DNS is to the Internet what directory assistance is to the telephone network.    In the telephone 
network, a person calls a well-known telephone number (like 411 or 555-1212), and tells the 
operator the name of the person they want to contact.    The directory assistance operator then 
supplies the appropriate number, and the caller can go ahead and place the call without further 
help.

Similarly, browsers and other Internet-aware applications need a way to convert network names 
like www.worldnet.att.net into the Internet’s version of telephone numbers, which are called IP 
addresses.    (IP addresses look like sequences of numbers, like 123.45.67.89.)    One way to 
accomplish this would be to give every computer on the Internet a comprehensive “phone book” 
listing network names and their corresponding IP addresses, but this would be impractical, since 
this list would be immense and would become obsolete almost immediately.

Instead, the Internet’s approach is to use the Domain Name System, or DNS. You can think of 
DNS as a collection of server computers that act as directory assistance operators.    Not every 
server knows every name and IP address, but they know how to cooperate with each other to get 
the information they need, and they keep each other updated as they find out about changes in the
network.    So, when your PC software encounters a network name that it needs to translate into an
IP address, it asks your local Domain Name server, and DNS takes over from there.
Although DNS is absolutely critical to the Internet, most of the time users never have to think about
it.

See also: DNS Address.

DNS-related warnings and error messages:
Your system is enabled for another Domain Name System (DNS) server.
The server does not have a DNS entry.
Netscape is unable to locate the server: www.worldnet.att.net.



DNS Address
A DNS address is the IP address of a computer called a DNS server that can perform the name-to-IP 
address translations for the Domain Name System.    Following the analogy between DNS and the 
voice telephone network’s directory assistance service, the DNS address corresponds to the telephone
number used to contact directory assistence, like 411 or 555-1212.



Domain Address
A Domain Address is a unique name for a site on the Internet.    Domain addresses have names like:

worldnet.att.net
and:

whitehouse.gov



Email Address
Email An email address identifies a “mailbox” on the Internet.    If you know someone’s email address, 
you can send them electronic mail.    Email addresses look like:

ImaUser@worldnet.att.net



FTP (File Transfer Protocol)
File Transfer Protocol is a protocol that specifies how to connect to remote computers and transfer files
files back and forth.    FTP is a common way to upload and download large files.    Many computers on 
the Internet maintain archives of files which can be downloaded using FTP.



Home Page
There are two common interpretations of this term:

One interpretation is “the first page that you see when you start up your Internet browser”, which is 
www.worldnet.att.net by default.

Another interpretation is “the first page you encounter when you go to a Web site.”    In this context, a 
home page is frequently like a cover of a magazine, or a table-of-contents.



HTML (HyperText Markup Language)
HTML is a common format or code for describing “pages” of information on the World Wide Web.    
Web browsers like the AT&T WorldNet Service    software read pages of HTML-formatted data from 
Web servers.

Because browsers are written to understand HTML formatting information, they know how to display 
the contents of the page on the user’s computer.    To see the HTML code that corresponds to a web 
page you’re currently looking at, use the Source menu item under the View pulldown on the Netscape 
Navigator software.

By convention, files containing HTML-formatted data end in “.html” or “.htm”.



HTTP (Hypertext Transfer Protocol)
HTTP (Hypertext Transfer Protocol) is one of the key protocols on which the World Wide Web is based.
It specifies the rules for transmitting hypertext files around the Internet.    When a URL begins with 
“http://”, you are using HTTP to access that site.



Hypertext
In general, hypertext refers to any document that contains “active” links to other documents, or other 
parts of the same document.    “Active” links are links that you can follow easily, generally by clicking 
on some screen “hotspot” with a mouse.    This Troubleshooting Guide you are now reading is an 
example of hypertext.

On the World Wide Web, hypertext documents are formatted in HTML (Hypertext Markup Language), 
and are transmitted using HTTP (Hypertext Transfer Protocol).



IP Address

IP stands for Internet Protocol.    An IP address is a number like 123.12.34.5 that identifies a computer 
on the Internet.    It has essentially the same role in the Internet that a telephone number has in the 
telephone network.

See also TCP/IP.



LAN (Local Area Network)

A Local Area Network (LAN) is a group of interconnected computers that are fairly close together, 
typically in the same building.    Computers on a LAN can usually be set up to share disk drives, 
printers, and other resources.



Netnews
You can think of the Internet as a collection of interconnected computers, but sometimes it’s more 
helpful to think of it as a collection of millions of interconnected people, with countless different 
interests and inclinations.

Many people on the Internet are looking for ways to share information with others with similar interests.
The result is that thousands of “communities” exist on the Internet, and Netnews is one of the ways 
members of those communities find and communicate with each other.    It works like a sort of 
community bulletin board, where individuals can post messages, and everyone else can read them and
respond.

Each “bulletin board” exists on the Internet as a newsgroup.    There are literally tens of thousands of 
newsgroups on the Internet, and many more are added every day.    For information on how to use 
Netnews, see the Netscape Navigator Handbook.



Post Office 
On the Internet, a post office is a computer capable of receiving and storing email.    When you want to 
read your email, your mail program logs in to a post office and downloads the email from there.    Just 
like a real post office, an email post office doesn’t normally keep copies of the email it delivers to you.

Most PCs on the Internet today communicate with a post office using a protocol known as POP-3, or 
Post Office Protocol.



Protocol
A protocol is an agreed-upon set of rules that spell out in great detail how computers (or more 
precisely, computer programs) must behave when communicating with each other.    As long as all 
computers on a network abide by the protocols, they can communicate successfully.

There are numerous different communication protocols in use on the Internet, because different 
protocols are designed to handle different sorts of tasks.    Common protocols in use on the Internet 
include TCP/IP, HTTP, FTP, SMTP, POP-3, and many others.



Proxy
A network proxy acts as a sort of mediator between a group of users (typically on a LAN) and the 
Internet.    Sometimes proxies are used for security, sometimes to improve network performance, and 
sometimes for both reasons.

When a user on a proxy-equipped LAN needs to connect to a URL outside the LAN, the user’s browser
connects to the proxy instead of connecting directly to the outside site.    The proxy then fetches the 
data from the Internet, and feeds it back to the user that requested it.    If another user on the LAN then 
requests the same data, the proxy can provide it immediately, without having to go back out to the 
Internet again.



SMTP (Simple Mail Tranfer Protocol)
SMTP is a standard Internet protocol used for sending email.    When you want to send email, your mail
program logs in to an SMTP server, and transfers your email messages to it.    The SMTP server then 
takes care of distributing the email from there.



TCP/IP (Transmission Control Protocol/Internet Protocol)
TCP (Transmission Control Protocol) and IP (Internet Protocol) are the basic protocols that control how
data moves around the Internet.    IP takes care of addressing, figuring out how to get chunks of data 
called packets to the right computer in the network.    If you think of an IP address as like a phone 
number, think of Internet Protocol as the rules that allow the switches in the network to work together to
place your call.    Similarly, TCP is the set of rules that control how long streams of data are broken up 
into packets, sent across the net, and reassembled at the other side.

TCP and IP together form the foundation on which most other Internet protocols are built, including 
SMTP, NNTP, and HTTP.



URL (Universal Resource Locator)
A URL is the standard way of specifying the address of a resource of information on the World Wide 
Web.    URLs have names like

http://www.worldnet.att.net/welcome.html
and

ftp://www.someplace.com/somefile.zip

The term “resource” covers a lot of ground – a resource can be a web page, a file that can be 
downloaded, a newsgroup, and numerous other things.    The part of the URL preceding the colon can 
give you a clue about the resource.    Thus, in the examples above, the “http” indicates that HTTP will 
be used to retrieve the first resource, and that FTP will be used to retrieve the second.



WWW (World Wide Web)

The World Wide Web is a collection of information that resides on computers around the world.    This 
body of information has some specific characteristics that combine to make it both exciting and useful:

    The computers share this information over the Internet.
    The information is in the form of hypertext, so that the information on one computer’s “Web site” may 
have links to information on other Web sites all around the Internet.    This collection of links and cross-
references weaves the individual collections of information into a truly unified global web of information.
    Web sites have pages that can contain not only text information but also graphics, sound, animation, 
and opportunities for interaction with other users.
    Browser software like the AT&T WorldNet Service Internet client allows users to easily view Web sites 
and traverse the hypertext links that interconnect them by simply clicking with a mouse.
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